Abstract

This user guide documents the PureConnect Customer Feedback Management solution for customer Post-call surveys and On-demand surveys. Learn how Interaction Feedback, an IC Business Manager application module, allows business users to create customer feedback surveys, analyze survey results, and view the results of surveys in real-time and in Interaction Reporter Interaction Feedback reports.

For the latest version of this document, see the PureConnect Documentation Library at: http://help.genesys.com/cic.

For copyright and trademark information, see https://help.genesys.com/cic/desktop/copyright_andTrademarkInformation.htm.
# Table of Contents

- Table of Contents ........................................................................................................... 2
- Introduction ..................................................................................................................... 4
- About this information .................................................................................................... 5
- Referenced information ................................................................................................... 6
- Overview ......................................................................................................................... 7
- Interaction Feedback components ................................................................................... 8
  - Interaction Feedback Client .......................................................................................... 8
  - Exploring the client interface ....................................................................................... 8
  - Navigation Pane ........................................................................................................... 9
    - Survey Results ........................................................................................................... 9
    - Survey Definition ...................................................................................................... 9
    - Library ...................................................................................................................... 9
  - Interaction Feedback Toolbar ...................................................................................... 10
  - Interaction Feedback Tools ......................................................................................... 10
- Shortcut menus ................................................................................................................ 10
- Interaction Feedback configuration container ................................................................... 11
- Interaction Feedback Statistics View ............................................................................... 12
- Interaction Feedback Reports .......................................................................................... 13
- Installation and Configuration ....................................................................................... 14
  - Planning for installation ............................................................................................. 14
    - Software and hardware requirements ........................................................................ 14
    - Database requirements ............................................................................................. 14
    - License requirements ............................................................................................... 14
      - Confirming Interaction Feedback licenses .......................................................... 14
  - Installing Interaction Feedback .................................................................................. 15
    - IC server installation .............................................................................................. 15
    - Client installation .................................................................................................... 15
  - Configuring Interaction Feedback ............................................................................... 16
    - Configuring settings ............................................................................................... 17
    - Assigning Access licenses ....................................................................................... 17
      - Interaction Feedback Access license .................................................................. 18
    - Assigning Access Rights ......................................................................................... 18
      - Administrator Access rights .............................................................................. 18
      - Access Control rights ......................................................................................... 19
  - Starting the Interaction Feedback Client ................................................................... 21
    - Interaction Feedback module ................................................................................... 21
    - Getting Started Help ............................................................................................... 21
- About Interaction Feedback customer surveys ............................................................... 22
  - Overview of creating Interaction Feedback surveys .................................................. 22
    - Creating a survey group ......................................................................................... 23
    - Adding a survey to a group ...................................................................................... 24
    - Add questions to a survey ....................................................................................... 24
      - Add questions when creating a survey ................................................................. 24
      - Add questions to an existing survey ..................................................................... 25
    - Activate a survey .................................................................................................... 26
      - Activate a survey in Survey view ......................................................................... 27
      - Activate a survey in Survey Activation view ....................................................... 27
      - Deactivate a survey .............................................................................................. 28
  - Create a new survey .................................................................................................... 29
    - Create a post-call survey ......................................................................................... 29
    - Create an on-demand survey ................................................................................... 35
      - Add an on-demand survey to Interaction Attendant profile ................................ 41
  - Edit a survey ................................................................................................................ 41
    - Set the Minimum Acceptable Percentage ................................................................ 42
  - Add questions to a survey .......................................................................................... 42
    - Add questions to a survey ...................................................................................... 42
      - Add questions when creating a survey ................................................................. 42
      - Add questions to an existing survey ..................................................................... 43
  - Question templates .................................................................................................... 44
    - Library ...................................................................................................................... 44
    - Question Descriptions ............................................................................................ 46
Introduction

Interaction Feedback™ is the PureConnect Customer Feedback Management solution for automated post-call and on-demand customer surveys. It allows business users to create and manage customer feedback surveys, analyze survey results, and view the results of surveys in real-time. Interaction Feedback has an intuitive interface with ready-to-use templates to help you build effective satisfaction surveys that ask your customers discerning questions about the quality of their experience with your company’s products and services.

This document includes:
- An Overview of Interaction Feedback features and components
- Installation and Configuration information
- Steps to build Interaction Feedback customer surveys
- How to view survey results and real-time monitoring
- Information on accessing Interaction Feedback reports in Interaction Reporter
About this information

The information in this guide is for business users, contact center managers and supervisors, CIC system administrators, business managers, and report administrators. Users might also include Genesys Business Partners and anyone who is interested in learning how to create customer satisfaction surveys.
Referenced information

Because Interaction Feedback is integrated with Customer Interaction Center, there are additional technical references and guides that are referenced in this document. Documents are available in the PureConnect Documentation Library on your CIC server.

The latest versions of these documents can also be accessed from the PureConnect Documentation Library at https://help.genesys.com/cic.

The following technical references, Help, and links can provide additional information for Interaction Feedback.

- PureConnect Installation and Configuration Guide
- PureConnect Licensing Technical Reference
- Interaction Feedback Help
- Interaction Feedback Tables in the PureConnect Data Dictionary
- IC Business Manager User Interface Help Getting Started
- Interaction Administrator Help
- Interaction Supervisor Help
- Interaction Reporter Help
Overview

Interaction Feedback is an IC Business Manager program module that supports automated post-call customer satisfaction surveys and on-demand surveys. Interaction Feedback gives business users the ability to easily create surveys using the Create Survey Wizard. Surveys can be quickly created with pre-defined industry standard templates. Customized questions can be simply created using Interaction Feedback Tools, for creating prompts and managing questions.

Completed survey results are available for viewing immediately in the Interaction Feedback Client. Business users can get at-a-glance information for completed surveys using the Interaction Feedback Dashboard, giving organizations immediate insight into customers’ experiences. For more detailed Survey Results, Interaction Feedback has extensive search and filtering capabilities, providing summary and detailed information for specific completed customer surveys.

The Interaction Feedback Statistics View in IC Business Manager provides business users the ability to view real-time statistics for surveys in progress—surveys customers are in the process of taking—as well as completed surveys and surveys where participants have opted out or abandoned. Interaction Feedback also takes advantage of the Interaction Supervisor Alerting mechanism in IC Business Manager, which is triggered by survey scores. This allows business users to receive immediate notifications when surveys fail to meet a minimum acceptable score. Real-time monitoring provides valuable customer feedback and helps to understand what you are doing well and what immediate actions might need to be taken to meet customer expectations.

Interaction Reporter reports, available in IC Business Manager, include pre-defined reports for Interaction Feedback. These reports contain summary and detailed information on completed customer satisfaction surveys.

After installation, Interaction Feedback is easily configured in Interaction Administrator. Interaction Feedback settings are configured in its container under System Configuration. Licensing for accessing Interaction Feedback features is also controlled in Interaction Administrator.
Interaction Feedback components

This section contains a detailed overview of the following Interaction Feedback components.
- Interaction Feedback Client
- Interaction Administrator configuration container for Interaction Feedback
- Interaction Feedback Statistics View in IC Business Manager
- Interaction Feedback reports in Interaction

Interaction Feedback Client

The Interaction Feedback Client allows you to create effective customer satisfaction post-call surveys and on-demand surveys, and it provides you with the ability to view completed survey results.

Exploring the client interface

The Interaction Feedback module uses the features of IC Business Manager, making it easy to use.

The following quick explanation of the Interaction Feedback interface is meant to familiarize you with the most important features you’ll need to create a survey. You’ll find the detailed steps for creating a new survey in “Create a new survey”.

For Help while using Interaction Feedback in the workspace, press the F1 key. For additional information on using IC Business Manager menus, toolbars, and Navigation Pane, see IC Business Manager Help. To access this Help, from the Help menu click Getting Started.
Navigation Pane

The Interaction Feedback navigation pane provides easy access to its survey features in the following navigation panes: Survey Results, Survey Definition, and Library. It provides centralized navigation to survey components, which display their information in the workspace next to the navigation panes.

If the Interaction Feedback navigation pane is not displayed in the IC Business Manager window, from the View menu, point to Navigation pane and click Normal.

Survey Results

The Survey Results navigation pane allows authorized users to display the results of completed surveys in the workspace, using the Dashboard and Searches. Use the Dashboard for a quick graphical view of survey results by date. The Dashboard view includes the average score for a survey, the average ranking of a survey, and the number of surveys completed. For more detailed survey results, use the Public Searches folder and the Private Searches folder to build customized searches. Customized searches can be built with filtering attributes such as Ranking, Scored User, Survey Name, and Survey State.

Survey Definition

Use the Survey Definition navigation pane to: create Survey Groups, which organize surveys; create customer surveys, new or from a template; create new survey questions, or add questions from an existing template; and to activate a survey. Surveys and questions are edited and managed under Survey Definition. Surveys and questions can be saved as templates and used when creating new surveys.

Library

The Library navigation pane contains survey templates and question templates you create to use when creating surveys.
Interaction Feedback Toolbar

Interaction Feedback provides Toolbar buttons for frequently used commands.

Toolbar buttons are available depending on the task being performed. For example, when Survey Definition is selected, the button is available.

Interaction Feedback Tools

The Interaction Feedback Tools menu provides tools to Manage Prompts, Manage Question Categories, and Manage Rankings for your surveys and questions.

Shortcut menus

The Interaction Feedback interface supports shortcut menus that display the available commands specific to the current selection and context. To display available commands, right-click to see the shortcut menu.
Interaction Feedback configuration container

Global settings for Interaction Feedback are configured in an Interaction Administrator container under System Configuration.

Use the Interaction Feedback Configuration dialog to set file paths for Prompts and Recordings, and to set Audio Compression and Encryption parameters.
The Interaction Feedback Statistics View is accessed in IC Business Manager. It provides business users the ability to view real-time statistics for surveys in progress—surveys customers are in the process of taking—as well as completed surveys and surveys where participants have opted out or abandoned.

Interaction Feedback real-time monitoring also allows business users to create Alerts for surveys that are in progress.

For complete information on Interaction Feedback Statistics View, see the Interaction Supervisor Help in IC Business Manager.
Interaction Feedback Reports

Interaction Feedback reports are available in Interaction Reporter in IC Business Manager. There are four reports that contain summary and detailed information on completed customer satisfaction surveys. The reports include survey details including: user, average score, percentile, and specific scores by questions. The reports provide information for comparison between different users’ average survey scores over time. If Interaction Recorder data is available, a report shows comparisons between survey scores and quality scores.
Installation and Configuration

Interaction Feedback is an IC Business Manager program module that is installed with PureConnect Customer Interaction Center (CIC) components during CIC installation. If the CIC license includes the Interaction Feedback base license, during CIC server installation Interaction Feedback will be installed and available in Interaction Administrator for configuration.

Consider the following requirements when planning for your Interaction Feedback installation.

- **Software and Hardware requirements**
- **Database requirements**

Planning for installation

Consider the following requirements when planning for your Interaction Feedback installation.

Software and hardware requirements

Interaction Feedback has the same basic software and hardware requirements as the CIC servers, which are described in the PureConnect Installation and Configuration Guide, available in the PureConnect Documentation Library. Please note that Interaction Feedback is not supported on the TAPI Platform.

The latest version of the PureConnect Installation and Configuration Guide document can be accessed from the PureConnect Documentation Library.

Database requirements

The database space requirements for your CIC system will increase in order to store Interaction Feedback survey information and results. Please refer to the CIC Database Space Planning Spreadsheet in the Technical Reference Documents section of the PureConnect Documentation Library to determine the space requirements needed for Interaction Feedback.

License requirements

Interaction Feedback is licensed separately from CIC. Five Interaction Feedback component licenses are required. Be sure to purchase your Interaction Feedback licenses ahead of the time when you plan to install and test a new installation or upgrade from a previous release. The following licenses are required for Interaction Feedback.

<table>
<thead>
<tr>
<th>License</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I3_ACCESS_FEEDBACK</td>
<td>Interaction Feedback Client workstation access license. This license is required for an IC Business Manager user to access the Interaction Feedback module for survey configuration or results viewing and to view Interaction Feedback statistics within Interaction Supervisor. The license is also required for users to have a survey applied to an interaction in which they were a participant.</td>
</tr>
<tr>
<td>I3_FEATURE_BASE_FEEDBACK</td>
<td>This license component enables all feature functionality of Interaction Feedback on the CIC server. Having this feature component in the CIC server license bundle enables the Interaction Feedback survey subsystem and the configuration containers in Interaction Administrator. This Server license also enables the Feedback reports. Interaction Feedback base license for CIC server installation includes and automatically enables the I3_FEATURE_POST_CALL_FEEDBACK license, which enables post-call surveys, and the I3_FEATURE_INBOUND_FEEDBACK license, which enables on-demand surveys.</td>
</tr>
</tbody>
</table>

Confirming Interaction Feedback licenses

You can view the licenses on your system in Interaction Administrator by clicking the File menu, and then click License Management. Confirm that you have the necessary Interaction Feedback licenses on the Licenses page and the Features page.
Installing Interaction Feedback

IC server installation

Interaction Feedback is currently installed in the IC server installation procedure. When IC Server Installation is installed, server licensed components of Interaction Feedback are available and configurable through Interaction Administrator.

Client installation

Interaction Feedback Client is installed on client workstations using the **IC Business Manager Applications** workstation install from the PureConnect Customer Interaction Center (CIC) **.iso** file, located under *Workstation*. The install creates IC Business Manager shortcuts in the PureConnect folder of the Start Menu and on the Windows desktop.

To run the Interaction Feedback Client install on a workstation, follow these steps.

1. If you have not done so already:
   a. Download the CIC 2015 R1 or later **.iso** file from the PureConnect Product Information site at [https://my.inin.com/products/Pages/Downloads.aspx](https://my.inin.com/products/Pages/Downloads.aspx).
   b. Copy the **.iso** file to a file server (non-IC server) with a high bandwidth connection to the workstation(s) on which you will be running the CIC 2015 R1 or later installs.
   c. Mount the **.iso** file and share the contents to make them accessible to the workstation(s) on which you will be running the CIC 2015 R1 or later installs.
2. Navigate to the \**Installs\ServerComponents** directory on the file server.
3. Copy the IC Business Manager Applications **.msi** file, for example, **ICBusinessManagerApps_2018_R1.msi**, to the workstation on which you plan to run this install and double-click to launch it.
   The IC Business Manager Application Setup wizard starts.
4. On the Welcome screen, click **Next**.
   The Setup wizard guides you through the Interaction Feedback Client installation.
Configuring Interaction Feedback

After installation, use Interaction Administrator to configure Interaction Feedback settings, allocate licenses, and assign access control.

The Interaction Feedback container is in Interaction Administrator under System Configuration.
Configuring settings

The Interaction Feedback container is in Interaction Administrator under System Configuration.

To configure Interaction Feedback settings, select the Interaction Feedback container, and in the configuration pane on the right, double-click Configuration. The Interaction Feedback Configuration dialog is displayed.

On the Interaction Feedback Settings page, configure the following settings.

Prompts Path

Type the path from which the survey prompts are loaded. The default value for the prompts is C:\I3\IC\Resources\SurveyPrompts, when the IC Installation path is C:\I3\IC.

Recordings Path

Type the path where the recorded surveys are stored. This is where free-form survey answers are stored. The default value for the recordings is C:\I3\IC\Resources\SurveyRecordings or the recorder recordings directory if configured, when the IC Installation path is C:\I3\IC.

Audio Compression

Select the Audio Compression format to use when compressing survey recordings. The values are: audio/PCMU, audio/PCMA, audio/GSM, audio/x-truespeech, and audio/G726-32. The default value is audio/x-truespeech.

Assigning Access licenses

Access to Interaction Feedback is controlled through licensing in Interaction Administrator. The Interaction Feedback Access license is required.

Next, read more about assigning Interaction Feedback licenses.
**Interaction Feedback Access license**

Assign the Interaction Feedback Access license to give a user access to Interaction Feedback in IC Business Manager.

Assigning the Interaction Feedback Access license to a user (agent) allows the results of a survey to be visible to users with the Security Access Control to view Feedback survey results. If the agent is not assigned the Interaction Feedback Access license, the survey results are not included in survey reports and the survey is considered unlicensed.

To assign the Interaction Feedback access license, in Interaction Administrator, select the Users container, and double-click the user name in the right pane. The User Configuration dialog is displayed. Assign the Interaction Feedback Access license on the Licensing tab.

To assign this license, on the Licensing page, select the Interaction Feedback Access check box. For more information on configuring the Licensing page, press F1 to display the Interaction Administrator Help.

**Assigning Access Rights**

Access rights for Interaction Feedback are assigned in Interaction Administrator under People. Administrator Access and Access Control rights can be configured in the Users or Workgroups configuration dialogs.
**Administrator Access rights**

**Administrator Access** rights provide the ability to set access control for Interaction Feedback specific access rights in Interaction Administrator. You can assign this access to a user or a workgroup. To grant this access, on the Security page of the Configuration dialog, click **Administrator Access**.

Under **Interaction Feedback** select the **Interaction Feedback Administrator Access** check box.
Access Control rights

Access Control rights provide the ability to View and Modify Interaction Feedback surveys and groups. There are two categories of Access Control, View or Modify Feedback Survey Groups and View or Modify Feedback Surveys.

Access Control rights for Interaction Feedback are assigned in Interaction Administrator under People. Access Control rights are configured in the Users or Workgroups configuration dialogs.

To grant this access, on the Security page of the Configuration dialog, click Access Control.

On the Access Control dialog, under Feedback Surveys, under Feedback Surveys, select the group or survey View or Modify check box.
Starting the Interaction Feedback Client

To start the Interaction Feedback Client, from the Desktop, double-click the IC Business Manager icon.

The IC Business Manager logon dialog is displayed.

Use your CIC server credentials and the name of your CIC server Host to log on to IC Business Manager.

Interaction Feedback module

When you log on, the Interaction Feedback module is displayed in the IC Business Manager window. If the Navigation Pane is not displayed, on the menu bar, click View, point to Navigation Pane, and select Normal.

Getting Started Help

To view an online Getting Started Help for IC Business Manager modules, click the Help menu, and then click Getting Started. The Interaction Feedback Help is also available from the IC Business Manager Help menu.
About Interaction Feedback customer surveys

Interaction Feedback provides a simple solution to building surveys for measuring customer satisfaction. There are two types of surveys, Post-Call Survey and On-Demand Survey. An Interaction Feedback automated survey assists you in gathering and analyzing customer feedback faster and better than conventional survey methods.

An Interaction Feedback post-call survey contains:

- **Rule Conditions** that determine which customer calls will be offered the opportunity to take a survey.
- **Prompts** which invite the customer to take a survey, welcome the customer to the survey, and thank the customer for taking the survey.
- **Questions** that measure a customer's perception on satisfaction with the overall experience of the call, customer feedback on the agent's skills and knowledge, and the likelihood that the customer might buy or recommend your company's products.

An on-demand survey contains **Prompts** and **Questions**.

Overview of creating Interaction Feedback surveys

The basic steps in creating a survey are:

1. Create a survey group
2. Create a survey
3. Add questions to the survey
4. Activate the survey

This section contains an overview of these basic steps to create a customer survey. Detailed instructions for creating post-call surveys and on-demand surveys are later in this document. You'll find the detailed steps for creating a new survey in "Create a new survey".
Creating a survey group

Create survey groups to organize surveys into logical groups and to control user access to those surveys. To create a group, from the Interaction Feedback Navigation Pane, under Survey Definition, select Survey Definition.

The Add Group button is now available on the Toolbar.

Next, click the Add Group button. In the Create New Group dialog, type a Name and Description for your new group, and click OK. The new survey group is added to the bottom of the survey group list and is indicated by the group icon.

The next time Interaction Feedback is started, your survey group name is displayed in alphabetical order.
Adding a survey to a group

Use the Create Survey Wizard to add a new survey to a group. There are two types of surveys that can be created: Post-Call survey in which the caller chooses to participate, or an On Demand survey that is initiated through Interaction Attendant. To create a survey, under Survey Definition, select the survey group to which you want to add a survey.

The Add Survey button is now available.

To add a new survey, click Add Survey. The Create Survey Wizard starts.

Click Next and follow the wizard instructions to create a new survey.

Add questions to a survey

Use the Create Question Wizard to add questions to a survey. Questions can be added when you are creating a survey, or you can add questions to an existing survey.

Add questions when creating a survey
Questions can be added at the completion of the Create Survey Wizard by selecting the Create question now check box.

When you click Finish the Create Question Wizard is started.

Follow the wizard instructions to create one or more survey questions. For more information on using the wizard, see Create Question Wizard.

Add questions to an existing survey
To add questions to an existing survey, under the survey group, select the survey and click Add Question on the toolbar. The Create Question Wizard is started.

The wizard guides you through the process of creating questions for your survey. For more information on using the wizard, see Create Question Wizard. You’ll find the detailed steps for creating a new survey beginning.

**Activate a survey**

Activating a survey makes it available to IC server for post-call and on-demand customer surveys. An active survey cannot be modified.

There are two ways to activate a survey, in the Survey view and in the Survey Activation view.
Activate a survey in Survey view

To activate a survey while viewing a survey:
1. In the Survey Definition pane, select the name of the survey to be activated. The survey is displayed in the workspace.

2. Click Activate.

Activate a survey in Survey Activation view

To activate a survey from a list of all available surveys:
1. In the Survey Definition pane, select Survey Definition. The Survey Activation view is displayed in the workspace.

2. Select the name of the survey you want to activate.

3. Click Activate.
Deactivate a survey

In order to modify an activated survey, it must be deactivated.

To deactivate a survey in the Survey view, from the survey displayed in the workspace, click .
To deactivate a survey in the Survey Activation view, from the list of surveys displayed in the workspace, select the survey Name and click Deactivate .

When you click Deactivate, a confirmation dialog is displayed with three choices: Yes, No, or Cancel.

<table>
<thead>
<tr>
<th>Yes</th>
<th>When you choose Yes, all previous survey results will be purged, and the survey is deactivated.</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>When you choose No, survey results are not purged and the survey is deactivated. Previous survey results will be mixed with new survey results. Consider selecting No if you are changing something minor. However, this might cause confusion in long-term reporting, for example if you add a new question.</td>
</tr>
<tr>
<td>Cancel</td>
<td>When you choose Cancel, survey results are not purged and the survey is not deactivated.</td>
</tr>
</tbody>
</table>

Those are the basic steps for creating and activating a survey. Next you’ll read about creating specific Interaction Feedback post-call surveys and on-demand surveys.
Create a new survey

You can create a customized post-call survey or an on-demand survey using the Create Survey Wizard. Building a customized survey allows you to create your own rule conditions, prompts, and questions to ask your customers the specific questions you want to measure.

Create a post-call survey

Follow these steps to create a post-call survey.

1. Under Survey Definition, select the survey group for which you want to create a survey.

2. Click Add Survey.
   The Create Survey Wizard is started.
3. On the Create Survey Wizard Welcome page, click Next.
   The Library Selection page is displayed.

4. Select Create new survey, and click Next.
   The Survey Type Selection page is displayed.
5. On the **Survey Type Selection** page, select **Post-Call** and click **Next**. The **Survey Settings** page is displayed.

6. On the **Survey Settings** page, type a **Name** and **Description** for your new survey.

7. Select a **Rank Group** for your survey.
   For more information, see [Define a Rank Group](#).

8. If you want to record the audio for this survey, select the **Record calls that use this survey** check box.
   Do not select this box if you use Interaction Recorder to record calls.

9. Enter a **Minimum Acceptable Percentage** for this survey.
   This is the value that is used to create Alerts in Interaction Supervisor.
10. Click Next, the **Survey Invitation Conditions** page is displayed.

On the **Survey Invitation Conditions** page select the conditions to use when offering this survey.

1. In the **Rule Conditions** box, select one or more rules to decide when this survey will be offered.

2. In the **Rule description** box, click a highlighted variable for each rule to specify a value.

3. In the value dialog that is displayed, enter the requested value for the rule, and click **OK**. The specified values are displayed in the **Rule description** box.
4. Click **Next** to continue.

The **Survey Prompts** page is displayed.

On the **Survey Prompts** page, select the prompts for users when deciding to take the survey.

You can preview available prompts, or create a new prompt from this page.

The Invitation prompt can be configured to automatically present the survey to your customer. For more details, see the following information on configuring the Invitation prompt.

1. In the **Invitation** box, select a prompt that invites the customer to participate in this survey. This prompt is presented to the caller at the beginning of the interaction to participate in a survey at the end of the call. To preview the selected prompt, click the play button.

   **Note:**
   To automatically present a survey to the caller, configure the **Invitation** prompt to **None**.

To create a new prompt, select [add recording].
The Prompt Edit dialog is displayed.

Prompt Audio
To record an audio prompt from your telephone, select Station handset record, and click Record. To use an existing audio file for your prompt, select WAV file selection, and click Browse to select the file path.

Listen to Prompt
To listen to the prompt, in the Play To box, select the output device, and click Play.

Prompt Information
Type the name for this prompt in the Name box. Type the full text of this prompt in the Enter text-to-speech that will play if prompt is unavailable box.

When you have completed the Prompt Edit dialog, click Save.

2. In the Opt-in box, select a prompt that recognizes that the customer has chosen to take the survey, and it requests that the customer stay on the line after the interaction has concluded.

You can preview available prompts by clicking the play button.  
Or you can create your own Opt-in prompt by selecting [add recording].

3. In the Opt-out box, select a prompt that recognizes that the user has chosen not to take the survey.

You can preview available prompts by clicking the play button.  
Or you can create your own Opt-out prompt by selecting [add recording].

4. In the Welcome box select a prompt that welcomes the customer to the survey and provides instructions on how to take the survey, such as how to repeat a question or how to skip a question.

You can preview available prompts by clicking the play button.  
Or you can create your own Welcome prompt by selecting [add recording].

5. In the Finish box, select a prompt that is played at the completion of the survey.
You can preview available prompts by clicking the play button. Or you can create your own Finish prompt by selecting [add recording].

6. Click **Create**.

You have successfully created your post-call survey, and you have the following options:

- You can add questions to your survey by selecting the **Create question now** check box, and clicking **Finish**, which displays the **Create Question Wizard**
- You can click **Finish** and add questions later. When you click **Finish**, the survey is added to the end of the list of surveys in the survey group.

A new custom survey is indicated by a survey icon.

**Create an on-demand survey**

**Note:**

On-demand surveys are initiated in Interaction Attendant. For detailed instructions on adding an on-demand survey to an Interaction Attendant profile, see the Help topic, "Add inbound IVR surveys to Interaction Attendant profiles" in the *Interaction Attendant Help.*

Follow these steps to create an on-demand survey.

1. Under **Survey Definition**, select the survey group for which you want to create a survey.
2. Click Add Survey. The Create Survey Wizard is started.

3. On the Create Survey Wizard Welcome page, click Next. The Library Selection page is displayed.
4. Select **Create new survey**, and click **Next**.
   The **Survey Type Selection** page is displayed.

5. On the **Survey Type Selection** page, select **On Demand** and click **Next**.
   The **Survey Settings** page is displayed.
6. On the Survey Settings page, type a Name and Description for your new survey.
7. Select a Rank Group for your survey.
8. Enter a Minimum Acceptable Percentage for this survey. This is the value that is used to create Alerts in Interaction Supervisor.
9. Click Next. The Survey Prompts page is displayed.

On the Survey Prompts page, select the prompts to use for this survey. You can preview available prompts, or create a new prompt from this page.
1. In the **Welcome** box, select a prompt that welcomes the customer to the survey and provides instructions on how to take the survey, such as how to repeat a question or how to skip a question.

   To preview the selected prompt, click the play button.

   To create a new prompt, select [add recording].

   ![Survey Prompts](image)

   The **Prompt Edit** dialog is displayed.
Prompt Audio
To record an audio prompt from your telephone, select Station handset record, and click Record. To use an existing audio file for your prompt, select WAV file selection, and click Browse to select the file path.

Listen to Prompt
To listen to the prompt, in the Play To box, select the output device, and click Play.

Prompt Information
Type the name for this prompt in the Name box. Type the full text of this prompt in the Enter text-to-speech that will play if prompt is unavailable box.

When you have completed the Prompt Edit dialog, click Save.

2. In the Finish box, select a prompt that is played at the completion of the survey.

You can preview available prompts by clicking the play button. Or you can create your own Finish prompt by selecting [add recording].

3. Click Create. You have successfully created your on-demand survey, and you have the following options:
   - You can add questions to your survey by selecting the Create question now check box, and clicking Finish, which displays the Create Question Wizard
   - You can click Finish and add questions later. When you click Finish, the survey is added to the end of the list of surveys in the survey group.
A new custom survey is indicated by a survey icon.

**Note:** On-demand IVR surveys are initiated in Interaction Attendant. An on-demand survey must be marked **Active** in order to be available for use in Interaction Attendant. For more information, see [Activate a survey](#).

### Add an on-demand survey to Interaction Attendant profile

On-demand surveys are initiated in Interaction Attendant. For detailed instructions on adding an on-demand survey to an Interaction Attendant profile, see the Help topic, “Add inbound IVR surveys to Interaction Attendant profiles” in the Interaction Attendant Help.

### Edit a survey

To edit the settings for a survey, in the **Survey Definition** pane select the survey name under its group. The survey settings are displayed in the workspace.
Set the Minimum Acceptable Percentage

Use the **Minimum Acceptable Percentage** field to set a minimum score for a survey. Enter the Minimum Acceptable Percentage as a percentage of the maximum score for the survey. Click the information icon, next to the **Minimum Acceptable Percentage** box, to display a tooltip that assists you in selecting the percentage for the minimum acceptable score for the survey. The Minimum Acceptable Percentage is the value that is used for Alert notification in Interaction Supervisor.

The tooltip is displayed next to the **Minimum Acceptable Percentage** box.

When you have completed making your changes, click **Save Survey**.

Add questions to a survey

The **Create Question Wizard** will guide you through the process of creating a new question for your survey, or choosing an existing question template. Here’s how to add questions to a survey.

Add questions when creating a survey

Use the **Create Question Wizard** to add questions to a survey. Questions can be added when you are creating a survey, or you can add questions to an existing survey.
Questions can be added at the completion of the Create Survey Wizard by selecting the **Create question now** check box.

When you click **Finish** the **Create Question Wizard** is started.

Follow the wizard instructions to create one or more survey questions. For more information on using the wizard, see [Create Question Wizard](#).

**Add questions to an existing survey**
To add questions to an existing survey, under the survey group, select the survey and click Add Question on the toolbar. The Create Question Wizard is started.

The wizard guides you through the process of creating questions for your survey. For more information on using the wizard, see Create Question Wizard. You’ll find the detailed steps for creating a new survey beginning.

**Question templates**

Question templates contain the question settings, including prompts and response values, and can save time when creating a survey. You can choose question templates that you have created, from the Library.
Library

The Library pane contains the question templates that are available for your surveys.
Question Descriptions

To view the description of a question, from the Library, pause the mouse pointer on the question without clicking. The question description is displayed.

Create Question Wizard

To create a new question, access the Create Question Wizard in one of the following ways:
- At the end of the Survey Creation Wizard by selecting the Create question now check box
- By selecting a survey under Survey Definition, and clicking Add Question on the toolbar
- Right-click on a survey and select Add Question on the shortcut menu
Create a question

To create a question, start the Create Question Wizard in one of the ways described in the previous topic.

Create a question from a template

To add a question to your survey from a question template:
1. On the Create Question Wizard Welcome page, click Next.
2. On the Library selection page, select Create question from library, and from the list, select a question template.
The question is displayed in the Question Text box.

3. Click Create. Your question is created and added to your survey.

4. To create another question from a template, select Create another question check box. If you are finished, click Finish.

Questions are added under Survey Definition below the survey, and they are indicated by a question icon 📊.

Create a new custom question
To create a new custom question for your survey:

1. On the Create Question Wizard Welcome page, click Next.

2. On the Library selection page, select Create new question, and click Next.

3. On the Question Settings page, configure the Question type and Question settings.
**Question Type**
Select the type of question: True/False, Multiple Choice, Numeric Range, or Free-form (recording).

**Question Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type the name of the question.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a description for the question.</td>
</tr>
</tbody>
</table>

**Question Prompt**
From the drop-down list, select the question prompt for your new question, or create a new prompt by selecting [add recording].

You can preview available prompts by clicking the play button 🎥
Use the **Prompt Edit** dialog to add prompts to surveys and questions. When you select [add recording].
The **Prompt Edit** dialog is displayed.

**Prompt Audio**

To record an audio prompt from your telephone, select **Station handset record**, and click **Record**. To use an existing audio file for your prompt, select **WAV file selection**, and click **Browse** to select the file path.
Listen to Prompt
To listen to the prompt, in the Play To box, select the output device, and click Play.

Prompt Information
Type the name for this prompt in the Name box. Type the full text of this prompt in the Enter text-to-speech that will play box.
When you have completed the Prompt Edit dialog, click Save.

No Input Prompt
From the drop-down list, select the prompt that the customer will hear if there is no response to the question, or create a new prompt by selecting [add recording]. If you select <Default> a system prompt will play.

You can preview available prompts by clicking the play button .
Or you can create your own No Input prompt by selecting [add recording].

No Match Prompt
From the drop-down list, select the prompt that the customer will hear if the response is invalid, or create a new prompt by selecting [add recording]. If you select <Default> a system prompt will play.

You can preview available prompts by clicking the play button .
Or you can create your own No Match prompt by selecting [add recording].

Question Weight
Select the number for which you want to weight the importance of this question. The Question weight is used as a multiplier to calculate the final score for a question. For example, if the question is scored as a 9 with a weight of 2, the final score for that question is 18.
The Question Weight must be a non-zero value. It can be expressed as a decimal, for example 0.33, 1.5, or 5.55.
To not have the score for a question considered in the final score, use the Ignore score for question check box.

Ignore score for question
Select this box to not have the score for this question considered in the calculations for the final score of the survey.
4. Click Next.
   
   The Question Scoring page is displayed.

   The values to set for scoring vary depending on the type of question you selected: True/False, Multiple Choice, Numeric Range, or Free-form (recording).

5. When you have completed entering the scoring values, click Next.

   The Select categories for the question page is displayed.
6. Under Question Categories, in the User Defined Categories box, select the categories in which you want this question to be included. Click the arrow to add the categories to the Selected Categories box.

7. When you have finished, click Create. Your question is created and added to your survey.

8. To create another question, select the Create another question check box.

9. Click Finish.

Questions are added under Survey Definition below the survey, and the question type is indicated by an icon—for example:

- Numeric Range question
Note:
When the customer is given the survey, the configured prompts are presented. You can localize the Free-form recording confirmation prompts by configuring the value of the CSSurvey: Clear Language For Survey server parameter. The server parameter default value of Yes clears the language attribute of the call. If you do not want to clear the language attribute of the call when a survey begins, set the server parameter value to No. This allows the language attribute of the call to be used to localize the Free-form confirmation prompts.

Ordering questions in a survey

You can change the order questions appear in a survey. Here’s how:

1. From the Interaction Feedback Navigation Pane, select a Question in a Survey.
2. Right-click on a Question and on the shortcut menu click Up or Down.

The position of the question is reordered in the survey.

Editing questions

To edit a question, in the Survey Definition pane, under the survey, select the question. The question properties are displayed in the Question View in the workspace. You can update all of the question properties you configured when creating the question and configure additional properties, such as Retries and Timeout. You can also add branching logic, to configure when and how questions are presented based on customer responses to a question.

Retries and Timeout

Retries and Timeout values are configured on the question properties displayed in the workspace.

The Retries value is the total number of times a question is repeated if there is an invalid response. If there is no response after the number of retries, Interaction Feedback goes on to the next question. However, if there is no answer or no match for the first question, Interaction Feedback abandons the survey, allowing for hang ups. After the first question is answered, the remaining questions will go on to the next question if there is no answer or no match.

The Timeout value is the time, in seconds, to wait for a response after the prompt is completed. When the timeout expires, the No Input prompt is played.

To change the default values, display the question properties in the workspace, and update the values. When you have finished, right-click and in the shortcut menu, select Save question.

When your updates are complete, right-click and on the shortcut menu, select Save question.
**Add branching logic to a survey**

Adding branching logic to a survey allows the survey to change according to user responses to specific questions. In a survey with branches, relevant questions are offered according to the user’s specific situation. With branching, questions can be skipped or another question can be asked based on the user response to a branching question.

After your survey has been created and you have added all your questions to the survey, you can add branching to specific survey questions. Branching is configured in the Interaction Feedback Question View. Branching options can be configured for the following question types: True/False, Multiple Choice, and Numeric Range. Free Form (recording) questions cannot be configured as a branching question.

Each question type has its own set of branching options. For example, here are the branching options offered for a True or False Question:

![True False Question](image)

For step-by-step instructions on configuring each question type for branching logic in your survey, see Appendix B. Add branching logic to a survey.

**Create templates**

Templates are created from existing surveys and questions. Templates save the settings for surveys and questions, saving you time when creating new surveys. Templates are saved in the Library for reuse.
Create question templates

To create a question template from a question:
1. In the Survey Definition pane, select the question.
2. Click Copy to Question Library on the toolbar.

The new question template is added to the Library and is indicated with a question template icon.

Delete Custom Questions from the Library

You can remove custom questions that have been copied to the Question Library. To delete a question, the User must have the Access Rights to Modify All surveys.

To remove a custom question from the Library:
1. In the Library pane, select the question to be deleted.
2. Right-click and on the shortcut menu, click Delete item.
   You can only delete questions you have added to the Library.

Create survey templates

To create a survey template from a survey:
1. In the Survey Definition pane, select the survey.
2. Click Copy to Survey Library on the toolbar.

The survey template is added to the Library and is indicated with a survey template icon.
View Survey Results

Use Interaction Feedback to view completed survey results. You can use the Interaction Feedback Client Dashboard to view a summary of a completed survey, and you can create searches to display details for completed surveys.

Note:
You can view surveys in real-time using Interaction Feedback Monitor in Interaction Supervisor. For more information on real-time viewing, see Monitor surveys in real-time.

Completed survey results

There are two ways to view completed surveys using the Interaction Feedback Client: the Dashboard and searches. Use the Navigation Pane to display these views in the workspace.

View completed Survey Results using the Interaction Feedback Navigation Pane.
The Dashboard

Use Interaction Feedback’s Dashboard to view a summary of individual survey results. To access the Dashboard, under Survey Results select Dashboard. The Dashboard view is displayed in the workspace.

Manage the Dashboard

Use the Manage Dashboard toolbar button to add individual survey results to the Dashboard. Results are graphically displayed as a speedometer.

The graphical interface shows the average score for surveys completed since the selected Starting Date. The speedometer also displays the rank and the number of completed surveys.
Dashboard view

Speedometer pointer
The average percentage for the surveys taken is indicated by the pointer, between 0% and 100%.

Ranking
The average ranking of a survey is displayed on the face of the speedometer. The text that is displayed depends on the Rank label assigned when creating the Rank Group.

Odometer
The number of completed surveys is displayed by the odometer.

Survey name
The survey name is displayed below the speedometer.

Starting Date
Select this check box to display data for a range of dates beginning with a specific date to the current day.

Date field
Enter a specific date for which to display completed survey results. If the Starting Date check box is selected, the average completed survey results, beginning with this date to the current day, are displayed.

Update the Dashboard
The Dashboard data is updated every three minutes, or when refreshed. To refresh the data, right-click on the Dashboard, and on the shortcut menu click Refresh.

Access the Dashboard
To access the Dashboard, under Survey Results select Dashboard. The Dashboard view is displayed in the workspace.
Define surveys to display

1. To display survey results, click **Manage Dashboard** on the toolbar. The **Manage Dashboard** dialog is displayed.

![Manage Dashboard dialog](image)

2. Select the survey to be displayed from the **Survey** drop-down list.
3. To display survey results for a range of dates beginning with a specific date to the current day, select the **Starting Date** check box. Next, in the date field drop-down, select a starting date on the calendar that is displayed.
   
   Or, to display survey results for a specific date, clear the **Starting Date** check box, and in the drop-down calendar select the date for which you want the data to be displayed.
4. Click **Add**.
   
   The survey is added to the **Survey** list, and the survey is displayed on the Dashboard.
5. Continue to define as many surveys as you want to display on the Dashboard. When you have completed defining surveys, click **Close**.

![Manage Dashboard dialog](image)

**Searches**

You can create **Public Searches** and **Private Searches** to display completed survey results, in table form. After creating a search, use **Run a Search** to view the survey results in the workspace.

**Create a Search**

1. Select either the **Public Searches** folder or the **Private Searches** folder and right-click the selection.
2. On the submenu, point to **New**, and then click **Search**.
3. The search properties are displayed in the workspace.

The default search name is displayed in the Title box. To rename the search, type a new name.

4. To add an attribute to the search, click the New Attribute arrow.

5. Point to Survey, and click the attribute you want to add to your search.

The attribute is added to the workspace.

6. Select each attribute's search criteria and comparison operator.

- Use this button to add additional search criteria to an attribute.
- Use this button to delete a search criterion from an attribute.
7. To save a search, click Save Search on the toolbar.

Note:
You can also create Public and Private Searches using the Menu Bar and the Toolbar. Using the Menu Bar, from the File menu, point to New and click Search. On the Select Search Location dialog, select Private Searches or Public Searches. To create a new Interaction Feedback search using the Toolbar, click New, and on the Create New View dialog, click OK. On the Select Search Location dialog, select Private Searches or Public Searches.

**Search Attributes**

There are four search attributes specific to the Survey menu:

**Ranking**

The Survey Ranking attribute searches the selected Rank Group for surveys that match the selected rank using the comparison operator.

**Scored User**

The Survey Scored User attribute searches surveys for the selected agent using the comparison operator.

**Survey Name**

The Survey Name attribute searches surveys for the selected survey name using the comparison operator.

**Survey State**

The Survey State attribute searches surveys for the selected survey state using the comparison operator.
Search order

Surveys are searched using the attributes in the way they are ordered from top to bottom.

Use the green arrows to change the order of the search attributes.

Use the delete button to delete a selected attribute.

Run a search

To run a search, under Survey Results, select the search, and click Run Search on the toolbar. The search results are displayed in the workspace, in a grid.

Selecting Fields for the grid

To change the fields that are displayed in the grid, click the Field Chooser on the upper left of the grid. In the Field Chooser dialog select the fields to display in the grid.
The available fields for the search results grid are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent</td>
<td>Name of the agent whose call is associated with this survey</td>
</tr>
<tr>
<td>Caller</td>
<td>Name of the caller who opted-in to take the survey</td>
</tr>
<tr>
<td>Completed</td>
<td>Indicates a True or False value, True indicating all required survey questions were completed, and False indicating all required survey questions were not completed</td>
</tr>
<tr>
<td>Date</td>
<td>The Date and Time the survey occurred</td>
</tr>
<tr>
<td>Duration in seconds</td>
<td>The total time, in seconds, for the caller to take the survey</td>
</tr>
<tr>
<td>Interaction ID</td>
<td>The Interaction ID of the call associated with the survey</td>
</tr>
<tr>
<td>Origin</td>
<td>How the call came in to the system—possible values: Post-Call (used for opt-in surveys), External, Internal, Transfer, or Outbound</td>
</tr>
<tr>
<td>Rank</td>
<td>The Rank, or grade, based on the score associated with the survey rank group</td>
</tr>
<tr>
<td>Recording ID</td>
<td>The Recording ID of the call associated with the survey</td>
</tr>
<tr>
<td>Score</td>
<td>Total survey score</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the survey, which include:</td>
</tr>
<tr>
<td></td>
<td>• Abandoned — The caller hung up during the survey and the survey was abandoned</td>
</tr>
<tr>
<td></td>
<td>• Complete — The survey was completed</td>
</tr>
<tr>
<td></td>
<td>• Insufficient Resources — Licensing or some other resource was not available to present the survey</td>
</tr>
<tr>
<td></td>
<td>• Opt-Out — The caller opted out of the survey</td>
</tr>
<tr>
<td></td>
<td>• Error — There was an internal error when attempting to present the survey</td>
</tr>
<tr>
<td></td>
<td>• Not Answered — The call was not answered by an agent</td>
</tr>
<tr>
<td></td>
<td>• Caller Disconnect — The caller disconnected before the survey began</td>
</tr>
<tr>
<td>Survey Name</td>
<td>Name of the survey</td>
</tr>
<tr>
<td>Type</td>
<td>The type of survey, either Post-Call or On Demand</td>
</tr>
</tbody>
</table>
Tools

Interaction Feedback has a suite of tools to manage Interaction Feedback’s Prompts, Question Categories, and Rankings. To access these tools, click the Tools menu.

Manage Prompts

Prompts are pre-recorded audio files that:
- Invite the customer to participate in a survey
- Welcome the customer to the survey
- Ask the customer specific customer satisfaction questions
- Thank the customer for taking the survey

You can select prompts from existing Interaction Feedback prompts or create your own prompts.

Types of prompts

These are the types of prompts that you will be selecting on Interaction Feedback dialogs when creating surveys and questions.

Invitation

This prompt invites the customer, before interacting with an agent, to participate in a survey at the end of a call.

Opt-in

This prompt recognizes that the customer has chosen to take the survey, and requests that the customer stay on the line after the call has concluded.

Opt-out

This prompt is played when the user has chosen not to take the survey.

Welcome

This prompts welcomes the customer to the survey at the end of the agent interaction and provides instructions on how to take the survey, such as how to repeat a question or how to skip a question.

Questions

These prompts contain the specific questions that measure customers’ perceptions on satisfaction with the overall experience of the call, customer feedback on the agent’s skills and knowledge, and the likelihood that the customer might buy or recommend your company’s products.

No Input Prompt

This is the prompt that is played if there was no response to the question.

No Match Prompt

This is the prompt that is played if the customer’s response is invalid.

Finish

This prompt is played at the completion of the survey and thanks the customer for taking the survey.
Feedback Prompt Management

Use the Feedback Prompt Management tool to:
- Create new prompts
- Edit existing prompts
- Delete prompts
- Import WAV files for new prompts

To access the Feedback Prompt Management dialog, from the Tools menu, click Manage Prompts.

Available prompts are listed by Name, File and Description. To sort the list of prompts, click a column heading.
Create new prompts

To create a new prompt, click Add. The Prompt Edit dialog is displayed.

Prompt Audio

To record an audio prompt from your telephone, select Station handset record, and click Record.
To use an existing audio file for your prompt, select WAV file selection, and click Browse to select the file path.

Listen to Prompt

To listen to the prompt, in the Play To box, select the output device, and click Play.

Prompt Information

Type the name for this prompt in the Name box. Type the full text of this prompt in the Description or text to speech if no prompt has been added box. This is also the text that appears in the Description column.

When you have completed the Prompt Edit dialog, click Save to add your new prompt to the list of prompts.
Edit prompts

On the Feedback Prompt Management dialog, select the prompt, and click Edit. The Prompt Edit dialog is displayed with the current prompt settings.

![Prompt Edit Dialog]

After updating the prompt properties, click Save.

Delete a prompt

Use the Feedback Prompt Management dialog to delete an existing prompt. From the Tools menu, click Manage Prompts.

To delete an existing prompt, select the prompt in the Feedback Prompt Management dialog, and click Delete.

![Feedback Prompt Management Dialog]
Create a prompt from a WAV file

Use the Feedback Prompt Management dialog to create a prompt from an existing WAV file.

To create a prompt, click **Import**. The **Select one or more prompt WAV files to import** dialog is displayed. Locate and select the file name, and click **Open**.

A prompt is created using the WAV file name as the name of the prompt. To edit the prompt, select it and click **Edit**.

Manage Question Categories

Question Categories are created to organize questions into logical groups.

**Question Categories**

Use the Question Categories dialog to create and delete these categories. To access the Question Categories dialog, from the Tools menu, click Manage Question Categories. The Question Categories dialog is displayed.

**Adding categories**

To create a new category, click **Add**. A New Category is created and selected. Type a Category Name and press Enter.

**Deleting categories**

To delete an existing category, select it and click **Delete**.

Manage Rankings

Rankings are scaled scores used to rate or grade customer surveys. When a survey is completed, the final score is compared to the value defined in the survey’s ranking. When viewing survey results, the rank is displayed in searches and the Dashboard.
Define a Rank Group

Define ranking scales on the Questionnaires Rank Groups dialog. Assign a Rank Group to a survey on the survey configuration page. To access Rank Groups, from the Tools menu click Manage Rankings. The Questionnaires Rank Groups dialog is displayed.

To define a new ranking scale, first create a new group.
2. In the RankGroups list, right-click New Rank Group and click Rename to name the new Rank Group.
3. Type the new name for this rank group, and press Enter. The new name is displayed in the Group Name box in the Rank Groups view.

Define the ranking scale

To define the ranking scale for a Rank Group, select the Rank group, and edit its properties in the right pane.
1. To add a Rank, click Add.
2. New Rank is added to the Rank list and is selected. Type a name for the ranking.
3. Use the Ranks percentage slider to select a percentage for the Top Percent column. The Top Percent column defines the lowest percentage for the Rank. The upper percentage for a Rank is one percent lower than the Rank above it, or 100% if it is the highest Rank.

Define as many ranks as you choose to use in your ranking scale. Assign a percent for each Rank in the Top Percent column, setting the lowest percentage for the Rank in this column. For example, if A = 90–100 percent, the lowest percentage, 90, is set in the Top Percent column. Therefore, if B = 80–89 percent (89 being one percent lower than the lowest percentage of the rank above), 80 is set in the Top Percent column for B. Next, C = 70–79 percent, and 70 is set in the Top Percent column for the C. Rank D = 60–69 percent, and 60 is set in the Top Percent column for D. And the F Rank includes 50–59 percent when 50 is set as the lowest percentage for the Rank. If there is no lower Rank, the lowest Rank includes all scores below the lowest rank, including zero.
4. Click Save, and then click Close to exit the Questionnaires Rank Group dialog.
Assign a Ranking to a survey

To assign a ranking to a survey, view the survey in the workspace. In the Rank Group drop-down list, select a rank group to apply to the survey.
Monitor surveys in real-time

Use Interaction Feedback Statistics View in IC Business Manager to monitor surveys in real-time. Interaction Feedback Statistics provides the ability to view real-time statistics for surveys in progress as well as completed surveys and surveys where participants have opted out or abandoned.

Interaction Feedback real-time monitoring also allows business users to create Alerts for surveys that are in progress.

For complete information on Interaction Feedback Statistics View, see Interaction Supervisor Help in IC Business Manager.

To view surveys in real-time:

1. In IC Business Manager, click the Default Workspace module tab.

2. On the IC Business Manager toolbar, click New.

3. On the Create New View dialog, in the Group by box select Categories, and in the left pane select Interaction Feedback Status. Interaction Feedback statistics is displayed in the right pane.
4. Click **OK**.

   The Interaction Feedback Wizard starts with the **Survey Group** page displayed.

5. Select a Group in the list box. You can use the **Filter** box to find a Group listed in the box. Click **Next**.

6. On the Interaction Feedback Wizard **Survey Name** page, select a survey from the list and click **Finish**.

7. The **Interaction Feedback statistics** page is displayed in the Workspace.
The available Feedback Survey Statistics include:

- Survey errors today
- Surveys completed today
- Caller disconnects today
- Surveys offered last hour
- Surveys Opt-outs today
- Surveys Offered today
- Surveys bypassed (no license) today
- Agent no answer today
- Active surveys
- Surveys abandoned today
- Below minimum score
- Survey average score today
- Survey average score last hour

For detailed information on using the Interaction Feedback statistics page, press F1 for Help. The Interaction Feedback Statistics view Help is displayed.
## Interaction Feedback Reports

The results of the customer satisfaction survey data are collected, aggregated, and presented in Interaction Reporter in IC Business Manager. Reports include data from completed surveys. You can view, export, and print customer satisfaction survey reports. Reports are based on completed customer surveys.

**Note:**
If your survey contains a Free Form response as the last question, and the customer hangs up instead of pressing any key to complete the response, the survey state is marked Complete and the Complete Field for the report is marked as True. Comments that are ended by hanging up are displayed in the reports.

### Interaction Feedback Survey reports

The following Interaction Reporter reports are available for Interaction Feedback surveys:

**Satisfaction Trends (Line Graph)**

The Survey Satisfaction Trends report shows the satisfaction trend for an agent over time, by survey. The report is displayed in a line graph.

**Survey Scoring Detail**

The Survey Scoring Detail report shows the average survey score for agents during a date and time range. The report also shows survey detail by user, including survey scores, percentile, and score and weight by question.

**Survey Scoring Summary**

The Survey Scoring Summary report shows the average survey score for agents during a date and time range. It also includes a list showing Average Score and Percentile per User for the selected survey.

**Survey vs. Quality Scores**

This report compares survey and quality scores from Interaction Recorder for a specified agent.
Appendix B. Add branching logic to a survey

Adding branching logic to a survey allows the survey to change according to user responses to specific questions. In a survey with branches, relevant questions are offered according to the user’s specific situation. With branching, questions can be skipped or another question can be asked based on the user response to a branching question.

When creating a survey, determine the logic you want to use for the branching. For example, you might want to offer a question only if someone chooses a specific answer to a question, or based on a specific answer to a question, branch to a set of questions.

First, sketch out the questions for your survey and their logic. After you have created the survey and your survey questions, order your survey questions and specify where and how the survey questions branch. The order of the questions in a survey is important, as when you are assigning branching you can only branch forward to a question, you cannot loop back to a previous question.

Branching options are based on the type of question you have created. Branching options can be configured for the following question types: True/False, Multiple Choice, and Numeric Range. Free Form (recording) questions cannot be configured as a branching question.
Add branching to a question

After your survey has been created and you have added all your questions to the survey, you can add branching to specific survey questions. Branching is configured in the Interaction Feedback Question View. Branching options can be configured for the following question types: True/False, Multiple Choice, and Numeric Range. Follow these steps to add branching to a question.

Add branching to a True/False question

Based on the customer's response to a True/False question, branching options for an answer are: Any, Skip, True, or False. Here are the steps for configuring branching for a True/False question.

1. In the Navigation Pane, under the Survey, select the question you want to add branching to.
   The Question Settings are displayed in the workspace, including the Branching options.

2. Under Branching, for each possible Answer to the question that you want to specify a branching option for, select the question that you want to Branch To from the drop-down list. The default is <Next Question>, and included with the list of questions is the option <End Survey>.

3. When you have completed adding branching to the question, click Save Question.
   The branching for this question is displayed in the Navigation Pane below the question.
Add branching to a Multiple Choice question

Based on the customer’s response to a Multiple Choice question, branching options for an answer are: Any, Skip, and all DTMF Key responses are listed. Here are the steps for configuring branching for a Multiple Choice question.

1. In the Navigation Pane, under the Survey, select the question you want to add branching to.
   The Question Settings are displayed in the workspace, including the Branching options.

2. Under Branching, for each possible answer to the question that you want to specify a branching option for, select the question that you want to branch to from the drop-down list. The default is <Next Question>, and included with the list of questions is the option <End Survey>.
3. When you have completed adding branching to the question, click Save Question.
   The branching for this question is displayed in the Navigation Pane below the question.

Add branching to a Numeric Range question

Create a list of possible numeric ranges for customer responses and the questions to branch to when the responses falls within a specified numeric range. Here are the steps for configuring branching for a Numeric Range question.

1. In the Navigation Pane, under the Survey, select the question you want to add branching to. The Question Settings are displayed in the workspace, including the Branching options.
2. To create the first branch to a question for a numeric range, under **Branching**, select an **Operator** from the drop-down list.

3. Next, enter a **Value** in the field.

4. Select the question to **Branch To**, and click **Add**.

5. To add additional branches to your question, repeat steps 2 through 4.

6. To arrange the order of the questions to Branch To, use the **Up** and **Down** buttons.

7. When you have completed adding branching to the question, click **Save Question**.

   The branching for this question is displayed in the Navigation Pane below the question.

   ![Numeric Range Question Diagram](image)

   **Numeric Range Question**
   - **< 50**: Multiple Choice buying
   - **>= 50**: Wrapup Question

**Note:**
- Before you change the order of the questions in a survey, evaluate the impact it will have on the branching logic in that survey.
- You can only branch **forward** to a question; looping back to a previous question is not allowed.
- If question order changes that would cause a loop, the branching logic defaults back to Next Question.
- There is no branching for the last question in a survey.
- Branching logic is not saved to a question template.
- Branching logic is copied to a saved survey template.
## Change Log

The following table summarizes the updates made to the *Interaction Feedback Technical Reference*, since 4.0 product availability.

<table>
<thead>
<tr>
<th>Date</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-December-2011</td>
<td>Updated information on Minimum Acceptable Score value for a survey.</td>
</tr>
<tr>
<td>11-May-2012</td>
<td>Updated document for deleting custom questions from the Library</td>
</tr>
<tr>
<td>11-May-2012</td>
<td>Updated Copyright and Trademarks for 2012</td>
</tr>
<tr>
<td>04-June-2012</td>
<td>General edits to flow of document for new content</td>
</tr>
<tr>
<td>06-June-2012</td>
<td>Updated document for new On-demand surveys</td>
</tr>
<tr>
<td>14-June-2012</td>
<td>Added new information for adding branching logic to surveys</td>
</tr>
<tr>
<td>26-June-2012</td>
<td>Added additional information and references for initiating on-demand surveys in Interaction Attendant</td>
</tr>
<tr>
<td>17-August-2012</td>
<td>Updated information for fields in Search Results grid</td>
</tr>
<tr>
<td>22-August-2012</td>
<td>Added additional information for Deactivating a survey</td>
</tr>
<tr>
<td>10-September-2012</td>
<td>Updated Recording ID for dynamic link to recording</td>
</tr>
<tr>
<td>17-January-2013</td>
<td>Added information for additional ways to create Public and Private searches</td>
</tr>
<tr>
<td>28-January-2013</td>
<td>Updated Information for Rule Condition values being case sensitive</td>
</tr>
<tr>
<td>05-February-2013</td>
<td>Added information for Question Text box in Create Question Wizard</td>
</tr>
<tr>
<td>23-July-2013</td>
<td>Updated graphic for required Question Prompt</td>
</tr>
<tr>
<td>10-June-2014</td>
<td>Updated copyright and trademarks</td>
</tr>
<tr>
<td>23-June-2014</td>
<td>Removed references to deprecated <code>I3_ACCESS_FEEDBACK_SUPERVISOR_PLUGIN</code> license</td>
</tr>
<tr>
<td>23-June-2014</td>
<td>Updates for <code>I3_FEATURE_INBOUND_FEEDBACK</code> and <code>I3_FEATURE_POST_CALL_FEEDBACK</code> licenses</td>
</tr>
<tr>
<td>03-July-2014</td>
<td>Added new information for automatically presenting a survey to caller</td>
</tr>
<tr>
<td>25-August-2014</td>
<td>Updated documentation to reflect changes required in the transition from version 4.0 SU# to CIC 2015 R1, such as updates to product version numbers, system requirements, installation procedures, references to Product Information site URLs, and copyright and trademark information.</td>
</tr>
<tr>
<td>26-August-2014</td>
<td>Updated Installation instructions for Interaction Feedback client</td>
</tr>
<tr>
<td>14-January-2015</td>
<td>Updated Copyright and Trademarks for 2015</td>
</tr>
<tr>
<td>14-January-2015</td>
<td>Updated information for Interaction Feedback reports in Interaction Reporter</td>
</tr>
<tr>
<td>14-January-2015</td>
<td>Added information for Completed survey state for Free Form response</td>
</tr>
<tr>
<td>19-January-2015</td>
<td>Added information on Completed survey state for Free Form response</td>
</tr>
<tr>
<td>07-April-2015</td>
<td>Additional updates for Interaction Feedback reports in Interaction Reporter</td>
</tr>
<tr>
<td>08-April-2015</td>
<td>General usability documentation updates</td>
</tr>
<tr>
<td>06-July-2015</td>
<td>Added information for copying Search Results information fromdatagrid to clipboard</td>
</tr>
<tr>
<td>14-July-2015</td>
<td>Updated title page for new rebranding</td>
</tr>
<tr>
<td>02-October-2015</td>
<td>Updated screen captures for rebranding</td>
</tr>
<tr>
<td>Date</td>
<td>Updates</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>20-December-2016</td>
<td>Updated information for the Retries logic</td>
</tr>
<tr>
<td>12-April-2017</td>
<td>Updated Copyright and Trademark information</td>
</tr>
<tr>
<td>25-August-2017</td>
<td>Updated terminology for Genesys rebranding</td>
</tr>
</tbody>
</table>
| 05-September-2017     | - Updated rebranded screen captures for New Surveys and for New Question Wizards  
|                       | - Updated Title page for rebranding                                     |
| 21-September-2017     | Update for Survey View                                                  |
| 31-October-2017       | Updated licensing information for Access license                        |
| 19-December-2017      | Updated graphics for UI change for Minimum Acceptable Percentage        |
| 09-February-2018      | Updates for HTML5 conversion                                            |
| 20-February-2018      | Edits for Library                                                       |
| 15-January-2019       | Screen capture updates for UI and displayed text strings               |